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POWERPOINT

CUSTOMIZING A PRESENTATION

Section 3
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Links to 

Activities

3.1

3.2

3.3

3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

Skills

• Copy and paste items using the Clipboard task 

pane

• Find and replace text

• Insert and format WordArt

• Draw and customize objects

• Display gridlines

• Insert a text box

• Copy and rotate shapes

© Paradigm Publishing Inc.

Links to 

Activities

3.1

3.2

3.3

3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

Skills

• Create and format a table

• Insert action buttons

• Insert a hyperlink

• Format with a Slide Master

• Insert headers and footers

• Add sound and video

• Set and rehearse timings for a presentation

© Paradigm Publishing Inc.

Links to 

Activities

3.1

3.2

3.3

3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

Using the Clipboard Task Pane

• Open MPToronto.pptx in PowerPointS3 folder in 

your storage medium then save and name it

PPS3-01.

• Click Home tab then click Clipboard dialog box 

launcher, if items display in Clipboard task pane, 

click Clear All button in upper right corner.

• Make Slide 2 active then select Chris Greenbaum.

• Click Copy in Clipboard group.

ACTIVITY

3.1
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Links to 

Activities

3.1

3.2

3.3

3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

Using the Clipboard Task Pane

• Select Camille Matsui then click Copy, select 

Dennis Chun then click Copy, select Josh Hart then 

click Copy.

• Make Slide 3 active, position

insertion point immediately

right of Location Expenses,

press Enter, then press Tab.

• Click item in Clipboard task pane

representing Chris Greenbaum.

• Position insertion point immediately

right of Production, press Enter,

press Tab, then click item in Clipboard representing 

Camille Matsui.

ACTIVITY

3.1
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3.1
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3.10

3.11

Using the Clipboard Task Pane

• Make Slide 4 active, position insertion point 

immediately right of Royal Ontario Museum, press 

Enter, press Tab, then click item in Clipboard 

representing Dennis Chun.

• Position insertion

point immediately

right of Island

Airport, press Enter,

press Tab, then

click item in

Clipboard representing Dennis Chun.

• Position insertion point immediately right of King 

Street, press Enter, press Tab, then click item in 

Clipboard task pane representing Josh Hart.

ACTIVITY

3.1



2

© Paradigm Publishing Inc.

Links to 
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3.10

3.11

Using the Clipboard Task Pane

• Click Clear All in Clipboard task pane then click 

Close in upper right corner of pane.

• Make Slide 1 active then to insert MPLogo.jpg file 

click Insert tab then click Picture in Illustrations 

group. Make PowerPointS3 active folder then 

double-click MPLogo.jpg.

ACTIVITY

3.1
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3.11

Using the Clipboard Task Pane

• With logo inserted in slide, set

background color of logo to

transparent by clicking Recolor

in Picture Tools Format tab

then clicking Set Transparent

Color.

• Position mouse pointer in white

background color of logo then

click left mouse button.

• Size and move logo so it fills

slide.

• Save PPS3.01.pptx.

ACTIVITY

3.1
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Links to 

Activities

3.1

3.2
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3.4
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3.6

3.7

3.8

3.9

3.10

3.11

Finding and Replacing Text

• Open PPS3-01.pptx and make Slide 1 active.

• Camille Matsui has been replaced on

the project by Jennie Almonzo. Begin

to find and replace by clicking Replace

in Editing group in Home tab.

• Type Camille Matsui in Find what text box.

• Press Tab then type

Jennie Almonzo in

Replace with text box.

• Click Replace All button.

• At message saying two

replacements were made,

click OK.

ACTIVITY

3.2
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3.5
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3.7

3.8
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3.10

3.11

Finding and Replacing Text

• Josh Hart had to leave and is being replaced by 

Jaime Ruiz. At Replace dialog box, type Josh Hart

in Find what text box.

• Press Tab, type Jaime Ruiz in Replace with text 

box, then click Replace All button.

• At message saying two replacements were made, 

click OK.

ACTIVITY

3.2
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Links to 

Activities

3.1

3.2

3.3

3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

Finding and Replacing Text

• To change Manager to Director at Replace dialog 

box, type Manager in Find what text box.

• Press Tab, type Director in Replace with box, then 

click Replace All.

• At message saying one replacement was made, 

click OK.

• Close Replace box by clicking Close at right side of 

dialog box.

• Save PPS3-01.pptx.

ACTIVITY

3.2
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3.7
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3.11

Inserting and Formatting WordArt

• Open PPS3-01.pptx and make Slide 1 active.

• Click New Slide in Slides group.

• Click Layout in Slides group then click Blank layout.

ACTIVITY

3.3
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Inserting and Formatting WordArt

• To insert WordArt click Insert tab, click WordArt 

button in Text group, and Gradient Fill - Accent 1.

• Type Ring of Roses.

ACTIVITY

3.3
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Inserting and Formatting WordArt

• Select Ring of Roses, click Text Effects button in 

WordArt Styles group, point to Transform, then click 

Deflate.

ACTIVITY

3.3
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Inserting and Formatting WordArt

• Click in Shape Height box in Size group,

type 3, then press Enter.

• Select current measurement in Shape

Width box in Size group, type 7, then

press Enter.

• Drag WordArt text so it is

centered on slide as shown.

• Make Slide 4 active then

insert clip art image related

to money. You determine

size, position, and coloring

of image.

• Save PPS3-01.pptx.

ACTIVITY

3.3
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Drawing and Customizing Shapes

• Open PPS3-01.pptx and make Slide 2 active.

• Click New Slide in Home tab.

Make sure slide layout is Blank.

• Click Shapes in Home tab.

• Click Horizontal Scroll.

ACTIVITY

3.4
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Drawing and Customizing Shapes

• Position mouse pointer in slide, hold down left 

mouse button, drag to create shape as shown, then 

release mouse button.

• With image selected, change fill by clicking

Shape Fill in Drawing group then clicking Lavender, 

Accent 5, Lighter 60% option.

ACTIVITY

3.4
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Drawing and Customizing Shapes

• Click Drawing Tools Format

tab.

• Click Text Box in Insert

Shapes group then click

inside shape.

• With insertion point inside text box, click Home tab, 

click Font Size arrow, then click 24.

• Click Bold in Font group then click Center in 

Paragraph group.

• Type following text in text box:

• Click Align Text in Paragraph

group then click Middle.

• Save PPS3-01.pptx.

ACTIVITY

3.4
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Displaying Gridlines; Inserting a Text Box;

Copying and Rotating Shapes

• Open PPS3-01.pptx, make Slide 8 active then click 

Home tab.

• Click New Slide arrow then click Title Only.

• Click Click to add title then type Last Day of 

Filming.

• Turn on display of gridlines by clicking View tab 

then clicking Gridlines check box in Show/Hide 

group.

ACTIVITY

3.5
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Displaying Gridlines; Inserting a Text Box;

Copying and Rotating Shapes

• Click Insert tab then click Text Box in Text group.

• Position mouse pointer in slide then draw text box 

similar to shown. Use gridlines to help position 

mouse before drawing text box.

• Change font size to 24, turn on bold, change 

alignment to center, then type August 27. Click 

outside text box to deselect it.

ACTIVITY

3.5
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3.6

3.7
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3.9

3.10

3.11

Displaying Gridlines; Inserting a Text Box;

Copying and Rotating Shapes

• Click Insert tab, click More Shapes, then click 

Notched Right Arrow shape.

• Position mouse pointer at left side of slide, hold 

down left mouse button, drag to create arrow shape 

as shown, then release mouse button.

ACTIVITY

3.5
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3.7
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Displaying Gridlines; Inserting a Text Box;

Copying and Rotating Shapes

• With arrow image selected, copy arrow by 

positioning mouse pointer inside image until it 

displays with four-headed arrow attached. Hold 

down Ctrl key then left mouse button, drag arrow to 

right side of date, release left mouse button, then 

release Ctrl key.

• Click Drawing Tools Format

tab then flip copied arrow by

clicking Rotate in Arrange

group then clicking

Flip Horizontal.

ACTIVITY

3.5
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3.1

3.2

3.3

3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

Displaying Gridlines; Inserting a Text Box;

Copying and Rotating Shapes

• Use mouse pointer to draw border around three 

objects.

• Click Drawing Tools Format tab then center-align 

grouped objects by clicking Align in Arrange group 

then clicking Align Middle.

• Turn off display of gridlines by clicking Align then 

clicking View Gridlines option.

• Click outside objects to deselect them.

• Save PPS3-01.pptx.

ACTIVITY

3.5
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3.7

3.8
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Creating a Table in a Slide

• Open PPS3-01.pptx, make Slide 8 active then click 

Home tab.

• Click New Slide arrow then click Title and Content 

layout.

ACTIVITY

3.6
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3.7

3.8

3.9

3.10

3.11

Creating a Table in a Slide

• Click Click to add title in new slide then type 

Timeline.

• Click Insert Table in Content placeholder.

• At Insert Table dialog box, type 2

in Number of columns text box.

• Press Tab then type 9 in Number of rows text box.

• Click OK to close Insert Table dialog box.

ACTIVITY

3.6
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3.1

3.2
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3.6

3.7

3.8

3.9

3.10

3.11

Creating a Table in a Slide

• To make horizontal and vertical rulers display click 

View tab then click Ruler check box in Show/Hide 

group.

• To widen column 1, position mouse pointer on 

gridline in table until pointer turns into double-

headed arrow with two short lines, hold down left 

mouse button, drag to 6-inch mark on horizontal 

ruler, then release.

• With insertion point positioned

in first cell, type text shown.

Press Tab to move insertion

point to next cell. Press

Shift + Tab to move insertion

point to previous cell.

ACTIVITY

3.6
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Activities

3.1

3.2
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3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

Creating a Table in a Slide

• Click More button at right side of Table Styles group 

in Table Tools Design tab.

• Click Themed Style 1 - Accent 1 in drop-down 

gallery.

• Click Table Tools Layout tab.

ACTIVITY

3.6
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3.6

3.7

3.8

3.9

3.10

3.11

Creating a Table in a Slide

• To select first row in table, position mouse pointer at 

left side of first row in table until pointer turns into 

black, right-pointing arrow then click left mouse 

button.

• Click Center in Alignment group.

• Click in Height box in Table Size group, type 4.5, 

then press Enter.

• Save PPS3-01.pptx.

ACTIVITY

3.6
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3.1

3.2
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3.8
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3.10

3.11

Inserting Action Buttons and Hyperlinks

• Open PPS3-01.pptx and make Slide 1 active.

• To insert an action button to display next

slide, click Insert tab, click Shapes, then

click Action Button: Forward or Next option.

• Position crosshair pointer in lower right

corner of Slide 1 then drag to create

button that is one-half inch tall and wide.

• At Action Settings dialog box click OK.

ACTIVITY

3.7
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3.1

3.2

3.3

3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

Inserting Action Buttons and Hyperlinks

• With button selected, click

Drawing Tools Format tab

then click Colored Outline -

Accent 2.

• Select current measurement in height box, type 0.5, 

then press Enter. Select current measurement in 

width box, type 0.5, then press Enter.

• Instead of drawing a button on each slide, copy 

then paste it in other slides. To do this, make sure 

button is selected, click Home tab, then click Copy.

• Make Slide 2 active then click Paste. Continue 

pasting button in Slides 3 through 9.

ACTIVITY

3.7
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3.2
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3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

Inserting Action Buttons and Hyperlinks

• Make Slide 10 active then insert action button that 

displays first slide. To begin, click Insert tab, click 

Shapes, then click Action Button: Home.

• Position crosshair pointer in lower right

corner of Slide 10 then drag to create

button that is one-half inch tall and wide.

• At Action Settings dialog box, click OK.

• With button selected, click Drawing Tools

Format tab then click Colored Outline -

Accent 2 option.

• Click in Shape Height box, type 0.5, then

press Enter, click in Shape Width box,

type 0.5, then press Enter.

ACTIVITY

3.7
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3.2
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3.5

3.6

3.7

3.8

3.9

3.10

3.11

Inserting Action Buttons and Hyperlinks

• Make Slide 6 active then to create a hyperlink to 

museum Web site, select Royal Ontario Museum, 

click Insert tab, then click Hyperlink in Links group.

• At Insert Hyperlink dialog box, type www.rom.on.ca

in Address box then press Enter.

ACTIVITY

3.7
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3.1

3.2

3.3

3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

Inserting Action Buttons and Hyperlinks

• Run presentation beginning with Slide 1. Navigate 

through slide show by clicking action buttons. When 

Slide 6 displays, click the Royal Ontario Museum

hyperlink.

• After viewing museum Web site, close browser by 

clicking File then Close and continue running 

presentation. After viewing presentation at least 

twice, press Esc key to end.

• Save PPS3-01.pptx.

ACTIVITY

3.7
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Links to 

Activities

3.1

3.2

3.3

3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

Formatting with a Slide Master

• Open PPS3-01.pptx and make Slide 1 active.

• Click View tab then click Slide Master button in 

Presentation Views group.

ACTIVITY

3.8
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Links to 

Activities

3.1

3.2

3.3

3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

Formatting with a Slide Master

• Select Click to edit Master subtitle style, click Home 

tab, then click Font dialog box launcher.

• At Font dialog box, change font to Cambria, font 

style to Bold, turn on small caps, then close Font 

dialog box.

ACTIVITY

3.8
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Links to 

Activities

3.1

3.2

3.3

3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

Formatting with a Slide Master

• Click top slide master in panel at left side of screen.

• Select Click to edit Master title style then click Font 

dialog box launcher.

• Change font to Cambria, font style to Bold, turn on 

small caps, then close Font dialog box.

ACTIVITY

3.8

http://www.rom.on.ca
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3.1
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3.6

3.7

3.8

3.9

3.10

3.11

Formatting with a Slide Master

• To insert Marquee Productions logo in slide master 

click Insert tab then click Picture in Illustrations 

group.

• Navigate to PowerPointS3 folder on your storage 

medium then double-click

MPLogo.jpg.

• Make sure logo is selected.

• Click Recolor button in Adjust

group in Picture Tools Format

tab then click Set Transparent

Color.

ACTIVITY

3.8
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Links to 

Activities

3.1

3.2

3.3

3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

Formatting with a Slide Master

• Position mouse pointer in white background color of 

logo then click left mouse button.

• Click in Shape Height box, type 0.5, then Press 

Enter.

• Drag logo to lower left corner of slide

master as shown.

• Click Slide Master tab.

• Click Close Master View in Close

group at right side of Slide Master tab.

• Print presentation as handouts with six

slides per page.

• Save then close PPS3-01.pptx.

ACTIVITY

3.8
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Links to 

Activities

3.1

3.2

3.3

3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

Inserting Headers and Footers

• Open NPCDivisionPresentation.pptx then save 

as PPS3-02.

• To insert footer that prints at bottom of each slide 

click Insert tab then click Header & Footer in Text 

group.

ACTIVITY

3.9
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Links to 

Activities

3.1

3.2

3.3

3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

Inserting Headers and Footers

• At dialog box with Slide tab selected, click Date and

time check box to insert a check mark, click Update

automatically option to insert a circle.

• Click Slide number

check box to insert

a check mark.

• Click Footer check box

then type Theatre Arts

Division in Footer box.

• Click Apply to All.

ACTIVITY

3.9

© Paradigm Publishing Inc.

Links to 

Activities

3.1

3.2

3.3

3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

Inserting Headers and Footers

• Make Slide 4 active.

• Click in Notes pane then type Include additional 

costs for equipment, costuming, set design, and 

other required expenses.

ACTIVITY

3.9

© Paradigm Publishing Inc.

Links to 

Activities

3.1

3.2

3.3

3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

Inserting Headers and Footers

• To insert a header in notes and handouts click 

Header & Footer in Insert tab.

• At Header and Footer dialog box, click Notes and 

Handouts tab.

• Click Date and time

check box to insert

a check mark then,

if necessary, click

Update automatically

option to insert a

circle.

ACTIVITY

3.9
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3.1

3.2

3.3

3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

Inserting Headers and Footers

• Click Header check box then type Niagara 

Peninsula College.

• Click Footer check box then type Theatre Arts 

Division.

• Click Apply to All.

ACTIVITY

3.9

Niagara Peninsula College

Theatre Arts Division

© Paradigm Publishing Inc.

Links to 

Activities

3.1

3.2

3.3

3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

Inserting Headers and Footers

• Print presentation as handouts with nine slides per 

page.

• To Print Slide 4 as notes page,

press Ctrl + P, at Print dialog box,

click down-pointing arrow at right

side of Print what option then click

Notes Pages.

• Click in Slides option button then

type 4.

• Click OK to close Print dialog box.

• Save PPS3-02.pptx.

ACTIVITY

3.9
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Links to 

Activities

3.1

3.2

3.3

3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

Adding Sound and Video

• Open PPS3-02.pptx and insert slide at end of 

presentation that displays video clip of a jet taking 

off then plays a sound clip. To begin, make Slide 7 

active, click Home tab, then click New Slide.

• Click Click to add title then type Let Your Career 

Take Flight!

• Click Click to add text, click Insert tab, click Movie 

button arrow, then click Movie from File.

ACTIVITY

3.10

© Paradigm Publishing Inc.

Links to 

Activities

3.1

3.2

3.3

3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

Adding Sound and Video

• At Insert Movie dialog box, navigate to 

SoundandVideo folder on CD then double-click file 

named Launch.mpeg.

• At message asking how you want movie to start, 

click Automatically.

ACTIVITY

3.10
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Links to 

Activities

3.1

3.2

3.3

3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

Adding Sound and Video

• Click Slide Show Volume in Movie Tools Options 

tab then click Low.

• Click Rewind Movie After Playing check box in 

Movie Options group to insert a check mark.

• Resize and position movie on slide so it fills text 

placeholder.

ACTIVITY

3.10

© Paradigm Publishing Inc.

Links to 

Activities

3.1

3.2

3.3

3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

Adding Sound and Video

• To add a sound clip click Insert tab, click Sound 

arrow, then click Sound from File.

• At Insert Sound dialog box, navigate to 

SoundandVideo folder on CD then double-click file 

named SoundClip.mid.

• At message asking how you want sound to start, 

click Automatically.

• Click Hide During Show

check box in Sound Options

group to insert a check mark.

• Click Loop Until Stopped check box to insert a 

check mark.

ACTIVITY

3.10
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Links to 

Activities

3.1

3.2

3.3

3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

Adding Sound and Video

• Drag sound icon so it is positioned in lower left 

corner of slide.

• Run presentation beginning with first slide and 

navigate through presentation. When Slide 8 

displays, movie clip will begin automatically and, 

when video finishes, sound will begin.

• After listening to sound clip for a short period, press 

Esc to end.

• Print only Slide 8.

• Delete Slide 8.

• Save PPS3-02.pptx.

ACTIVITY

3.10

© Paradigm Publishing Inc.

Links to 

Activities

3.1

3.2

3.3

3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

Setting and Rehearsing Timings

for a Presentation

• Open PPS3-02.pptx and make Slide 1 active.

• Click Slide Show tab then click Rehearse Timings in 

Set Up group.

ACTIVITY

3.11

Status bar

Pause slide time Repeat

© Paradigm Publishing Inc.

Links to 

Activities

3.1

3.2

3.3

3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

Setting and Rehearsing Timings

for a Presentation

• Wait until time displayed for current slide reaches 

four seconds then click Next.

• Set following times for remaining slides:

Slide 2     5 seconds          Slide 5     6 seconds

Slide 3     4 seconds          Slide 6     7 seconds

Slide 4     4 seconds          Slide 7     8 seconds

• After last slide displays, click Yes at message to 

keep new slide timings.

ACTIVITY

3.11

© Paradigm Publishing Inc.

Links to 

Activities

3.1

3.2

3.3

3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

Setting and Rehearsing Timings

for a Presentation

• Double-click Slide 1 to change to Slide view.

• Set up slide show to run continuously by clicking 

Set Up Slide Show in Slide Show tab.

• At Set Up Show dialog box, click Loop continuously 

until ‘Esc’ check box.

• Click OK to close dialog box.

ACTIVITY

3.11

© Paradigm Publishing Inc.

Links to 

Activities

3.1

3.2

3.3

3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

Setting and Rehearsing Timings

for a Presentation

• To insert a sound clip that will play throughout 

presentation click Insert tab, click Sound arrow, 

then click Sound from File.

• At Insert Sound dialog box, navigate to 

SoundandVideo folder on CD then double-click file 

named SoundClip.mid.

• At message asking how you want sound to start, 

click Automatically.

• Click Hide During Show check box in Sound 

Options group in Sound Tools Options tab to insert 

a check mark.

ACTIVITY

3.11

© Paradigm Publishing Inc.

Links to 

Activities

3.1

3.2

3.3

3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.11

Setting and Rehearsing Timings

for a Presentation

• Click down-pointing arrow at right side of Play 

Sound option box then click Play across slides.

• Drag sound icon to lower left corner of slide.

• Run presentation beginning with Slide 1. The slide 

show will start and run continuously. Watch 

presentation until it has started for second time then 

end show by pressing Esc.

• Print presentation as handouts with nine slides per 

page.

• Save and then close PPS3-02.pptx.

ACTIVITY

3.11


